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BEFORE YOU BEGIN THE SOFTWARE LOAD - CAUTIONS AND WARNINGS

Important: If your system is connected to a Hospital Network, disconnect it before proceeding.
Failure to disconnect the SGI computer can corrupt the software load process.

Important: During the Install GUI phase of the software load, be sure the <Num Lock> key on
the keyboard is turned off. If the <Num Lock> is on, the symptom seen is that nothing will
happen when trying to type in any of the edit fields in the Install GUI.

Important: When reconfiguring the system using the Install/Configuration GUI, remember to
push the <Configure> button on the verify tab before going to the Save info tab and doing a
Savelnfo. If you have not done the final configuration by pushing the <Configure> button in
the Verification tab, the information saved during Save Info will not reflect the latest changes
made in the Install GUI.

Important: If at any time during the OS load a problem occurs that causes you to stop the
install, correct the problem then reset the computer or power cycle the computer and begin the
OS install again from the start. This is necessary to insure a complete load. If this does not fix
your problem it may be necessary to do a low level format on the system drives. Refer to
Appendix C for this process.

Important: If the site will be using the “YP” networking option, do not turn YP on until after the
InSite IIP option has been configured and checked out. If YP is turned on first, it will cause the
InSite checkout to fail.
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1- LOADING HOST COMPUTER - OVERVIEW & PREPARATION

This procedure covers installing software for the OpenSpeed system. The software is a
modification of the 8.3 software, so any references to this release will be applicable.

1-1 Required Media

* |IRIX 6.5 Operating System CDROM Set, Disk 1 of 2 and Disk 2 of 2
* |IRIX 6.5.4 Boot/Update CDROM (use correct revision)
* MrApps - MR Applications CDROM
* MrpResSrv - MR Restricted Service CDROM (GE Service use only)
or MrpAdvSrv - MR Advanced Service CDROM (Licensed In-House Customers)
» savelNFO - MaxOptix MOD Media (Either blank or previously used)

DO NOT PROCEED UNLESS YOU HAVE THIS MEDIA AVAILABLE

1-2 Archive Images

This installation instruction will erase any current images left in the database. Archive all
images BEFORE continuing with this procedure.

1-3 Required Information Prior To Loading Software

First collect vital site information listed below to insure the install will not be stopped for lack of
site specific information (and in case Restorelnfo fails). To collect this info:

1. On the Service Desktop, select [Install]; type operator <Enter> for the password.

2. Look in Hardware Configure, Network info, and System Configure buttons for current
site information. Refer to Appendix A for instructions on how to locate the site information.
Record your Site configuration information in Table 1-1.

Note
The “V” in the Table 1-1 indicates what the configuration should be set to for
OpenSpeed.

» Unique Internet IP Address for Host (Networked systems only).

* Unique Internet IP address for PC Computer.

» Unique Internet IP Address for Laptop port.

* Netmask

* TPS Subnet ID

» Domain Name

* Hospital Name

* Hosthame (Unique name for this system. Name must begin with Alpha character.
Beginning the name with a number will cause the system to not come up. ).

» Unique ID (from GECARES specific to site)

» Service ID (from GECARES, assigned when first dispatch is opened on system)

» Suite Name: This name should be at least, but no more than 4 characters.

* Network Speed

* Weight Unit
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Field Strength
Gradient Type
RF Amp Type
» Coil Type
* Receiver Bandwidth
» System Type (Echospeed, Highspeed, Horizon) *
 Modem Type *
« Camera name * * These entries are not found in
« DASM type * the Instqll GUI. They are acquired
by physically checking the system.
TABLE 1-1
VITAL SITE INFORMATION
ENTRY VALUE ENTRY VALUE
Host IP: Host ID:
Netmask: Unique ID:
(Default is 255.255.252.0)
Domain Name: Resonator |  BRM __ CRM Y. ORM
Module: SPRM
IWS PC IP: RF Amp Type: | __ Tube Type RF PEN II
___1.0T Teli Solid State RF
__1.5T Analogic Solid State RF
v_ 0.7T Analogic Solid State RF
___0.5T Analogic Solid State RF
FE Laptop IP: Service ID:
TPS Subnet IP: Weight Unit:

Network Speed:

Field Strength:

__ 05T V¥ 07T __1.0T
15T  3.0T _ 40T

Host Name:

(Name can’t begin with a number.)

Gradient Type:

__ 8645 Single or Double Bay
V8280 SGD Base System
__ 8651 SGD HighSlew

8915 ACGD

Hospital Name:

Camera Type:

Suite ID:

DASM Type:

Digital (LCAM)  Video (VDB)

Package Name:

__EchoSpeed SR120
___EchoSpeed SR150
__EchoSpeed SR190
__ HIiSPEED SR77
V_Base (Horizon) SR20
SIGNASP SR12

Receiver BW:

__62kHz __ 125kHz
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IMPORTANT!
IT IS CRITICALLY IMPORTANT TO ENSURE THE CORRECT VALUES ARE
ENTERED FOR SYSTEM TYPE, GRADIENT TYPE, FIELD STRENGTH, RF
TYPE, AND COIL TYPE BEFORE DOING THE MRAPPS LOAD. THESE
VALUES DETERMINE WHAT PROTOCOLS AND COIL CONFIGURATION
FILES ARE LOADED.

Check (J) the Options installed at this Site on the System Options Table 1-2 below. After
loading software and doing Restore Info, verify that all the options are still available to the
customers. If any keys are missing, reactivate them using the option key floppy, or MOD.

TABLE 1-2
SYSTEM OPTIONS DATA TABLE
SITE OPTIONS SITE OPTIONS

Echo Planar Imaging (not available) Tagging
Fast Gradient Echo Sgdperf
Cine DW-EPIEZ
Fast Spin Echo & FLAIR iDrive Pro
Time of Flight iDrive
Phase Contrast Vascular Imaging SmartPrep99 Upgrade

Research

Probe99 Upgrade

Proactive Service

Functool

Research PSD

Voxtool

Videoconferencing

Interavascular Imaging

SGD_ EchoSpeed

Clariview

DW EPI

Multislice Multiangle

FLAIR EPI

SPECIAL

Smart Prep

SSFSE

Three Plane Localizer

HIS RIS

E3D TOF

FSE XL

Bloodsupp

Fastcine
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1-4 Savelnfo and Saving System Information Entered In The Install GUI

1-4-1 Savelnfo

A Savelnfo should be done before starting the install to save the latest system configuration
files, calibration files, and protocols.

1. Insert the your Savelnfo MOD or a new MOD into the drive.

2. From the Service Desktop select [Install]. In the Install Tool window, type operator
<Enter> at the password prompt.

a. In the Install GUI, select the Save/Restore tab.

b. There are four options: [Save Information], [Save Protocols], [Restore Info], and
[Restore Prot]. To save all information, select [Save Information]; this saves all
system calibration and configuration files, along with customer protocols. The
[Save/Restore Protocol] option is intended as a means to quickly save just customer
protocols on the same or different MOD.

c. When Savelnfo is complete, remove the MOD media and write the date on it.

1-4-2 Save Gl Configurations

If you are loading software on a system already at 8.3 or 8.4 software, create a Gl (Guided
Install) configure MOD from the Guided Install File menu.

1. Insert the your normal Savelnfo MOD or a new MOD into the drive.
2. Attop left corner of the Install GUI, select <File> then <Save GI Configuration to MOD>.

Note
The “save to MOD” process does not create a complete Savelnfo disk. It only
creates a copy of the information already entered in the GUI tabs for later use to
update the GUI tabs during a new install. (Savelnfo uses the Save/Restore tab.)
The <Save Gl Configuration to MOD> and Savelnfo can be saved on the same
MOD. A separate partition is built for each.
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2- HOST OPERATING SYSTEM SOFTWARE LOAD
Initial Conditions:

* Allimages archived (Section 1-2).
» System information recorded (Section 1-3); Savelnfo performed (Section 1-4).
» System disconnected from Hospital Network.

Procedure:

1. If the system is not up and running, switch on power at this time and continue with step 2.
If the system is already running, go to the Service Desktop and select [Shutdown]. When
prompted, click on the [Restart Button].

2. Stop the reboot process; click on the [Stop For Maintenance] button when it appears.

Select [Stop For
Maintenance] button.

Stop For Mairtenance

3. Click on the [Enter Command Monitor] button when it becomes available.

4. Insert the IRIX 6.5 CD labeled “Boot/Update” into the CDROM Drive on the workstation
(right side). On the command line type the following (user responses are bolded text):

Type of the following:

>> poot -f dksc(1,3,8)sash64 dksc(l,3,7)stand/fx.64 --x <Enter>

fx: "device-name" = (dksc) <Enter>

1;x: ctlr# = (0) <Enter>

1.‘x: drive# = (1) <Enter>

1;x> r/iro <Enter>

1.‘x/ Repartition/RootDrive: Type of Data Partition = (xfs) <Enter>
1;x> conti nue? yes <Enter>

1.‘ x> /sy <Enter> (This is a lower case L , /, lower case s, and lower case y.)

1;x> exit <Enter>

5. At this point the system will reboot to the PROM startup screen. Select [Install System
Software] button. A pop up window opens and asks you where to install from. Choose,
[Local CD-ROM], select [Install]. Then select the [Continue] button.



GE MEDICAL SYSTEMS HOST SOFTWARE INSTALL OPENSPEED
REV 1 OW2SCA9A.DOC

If you are working with newly formatted disk drives or new, never used disk drives, you
will be told by the system during this boot that the system was unable to mount the “/root”
file system. The system will stop with the statement "press Enter to invoke C shell csh:".
If you see this message, type the following:

.press Enter to invoke C shell csh: <Enter>
# mkfs /dev/dsk/dks0d1s0 (This is /dev/dsk/dks zero d one s zero.)
# exit <Enter>

6. The next system message should be “Trying again to mount /dev/dsk/dks0d1s0 on /root.”
If you get this message, continue with step 7. Otherwise...

If you are working with a newly formatted drive you may get a message similar to:
/ dev/ dsk/ dks0d1s0: Invalid argunent No valid file system
found on: /dev/dsk/dks0dlsO This is your system disk:
wi thout it we have nothing on which to install software.

Do the following:
Make new fil e system on /dev/dsk/ dks0dlsO [yes/ no/sh/ hel p]: yes<Enter>
About to remake (nkfs) file systemon: /dev/dsk/dks0d1sO.
This will destroy all data on disk partition: /dev/dsk/dks0d1sO.

Are you sure? [y/n] (n): y<Enter>

Bl ock size of filesystem 512 or 4096 bytes? 512<Enter>

Doi ng: nkfs -b size=4096 /dev/dsk/ dks0d1s0

met a- dat a=/ dev/ r dsk/ dks0d1s0 i si ze=256 agcount =8, agsi ze=128612 bl ks
data = bsi ze=4096 bl ocks=1028895, i naxpct=25

log =internal |og bsize=4096 bl ocks=1000

real ti me =none bsi ze=65536 bl ocks=0, rtextents=0

Trying again to nount /dev/dsk/dks0d1sO on /root.

7. Continue as follows:
i nst > sh <Enter>

# mount /CDROM <Enter>

# ICDROM/mr_prep <Enter>

8. The system will run for about 6 minutes and then will prompt with:

“Please insert the First OS Disk (Pa) and then press <enter>".
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10.

11.

Put the OS CDROM Disk 1 of 2 into the CDROM Drive. Wait for 20 seconds, or until the
amber light on the CD Drive stops blinking, then push the <Enter> key.

After an additional 3-6 minutes, the system will again prompt with:

“Pl ease Insert the Second OS Disk (Pb), then press <enter>"

Put the OS CDROM Disk 2 of 2 into the CDROM Drive. Wait for 20 seconds, or until the
amber light on the CD Drive stops blinking, then push the <Enter> key.

Loading the rest of the Operating System off the second disk will take about 30 minutes
and will not require any user intervention.

When finished, the system will stop at the “#” prompt. Type the following to continue.

# exit <Enter> (to exit back to the original inst> prompt.)

| nst > exit <Enter>

Automatically reconfiguring the operating system.
....Ready to restart ... y <Enter> (Restarts the system)

The system will finish some processing and reboot. The OS load portion of the Software
Install is complete.

Important!

Do not log into EZ Setup. It is no longer used as part of Install.

Continue to Section 3 of this document for the MR_Apps software load.
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3- MR _APPS SOFTWARE LOAD

1. When the system is finished rebooting, log in as root. There is no password at this time.
You will first see a startup box that will asks for the MrpApps CDROM. See lllustration 3-1.

=l |

Load & Start Guided Install. ..
Insert MrpApps CDROM in the Drive

Loading From CDROM...
Load | | Close

GUIDED INSTALL LOAD SCREEN
ILLUSTRATION 3-1

2. Remove any CD from the CDROM drive and insert the MrpApps CDROM into the CDROM
drive. Wait 20 seconds or until the amber light on the CDROM drive stops blinking and
push the <Load> button. The Guided Install will load and start.

Note
Help documentation is built into the Guided Install GUI. Push the <Help> button
on the tab you need information for in the GUI. When the GUI first starts, press
the <What’s New> button for information on using the GUI.

3. On initial startup, a popup box will appear over the Guided Install interface describing the
tool and its use. After reading the information push the <OK> button to continue.

4. Next, a popup box (see lllustration 3-2) will appear over the Guided Install interface.
INSTALL CONFIGURATION POPUP SCREEN

n Load Install configuration from MOD?

OE Cancel

ILLUSTRATION 3-2

If you are reloading 8.3 or later software, insert the Savelnfo MOD (created in Section
1-4-2, Save Gl Configurations) then push the <OK> button to reinstall your last GUI install
configuration values. (The normal Savelnfo files are not restored at this point in the
software load. They will be restored in step 9.) You will verify the correct values were
restored by checking each tab in the next step.

10
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Important: The last Install GUI configuration can only be installed if it was
previously saved using the <Save Gl Configuration to MOD> option per Section
1-4-2, Save Gl Configurations.

If you did not perform Section 1-4-2, Save Gl, push the <Cancel> button to continue
manually with the install.

5. The Guided Install home screen is displayed. See lllustration 3-3.

Set Exam Number | Set Disk Limit | DASM | VCR Setup | HIS/RIS | Set TimeiDate

Metwork Info | System Configure | Hardware Configure | Edit Patient Data

-Home

Guided Install verson raaus

GUIDED INSTALL - HOME SCREEN
ILLUSTRATION 3-3

11
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6. Press the <Next Tab> button to move through active tabs from “Network Info” to “Set
Time/Data”. Fill out all empty entries or make any updates as appropriate. This
information should have been saved in Table 1-1 in Section 1-2 of this document. When
you reach the “Set Time/Date” tab, go to the “Set Time Zone” box and use the selections
to set the time zone your system is in. See lllustration 3-4.

Important
If the site will be using the “YP” networking option, do not turn YP on until after
the InSite IIP option has been configured and checked out. If YP is turned on first,
it will cause the InSite checkout to fail.

Display MAODICDROM Patches Reset Image/Error DB SprSnH Log file
" Verification = Soveliesion Option Keys SCP Service SWiPicture Thisf/insite

Set Exam Mumber | Set Disk Limit | DASM | VCR Setup | HIS/RIS I
Home |  MetworkInfo ' System Configure = Hardware Configure |  Edit Patient Data ||

'“m‘uﬂ . 1 Select the Time Zone
@ [ United States < here by clicking .
[} Eastern Time through the selections
[} Eastern Standard Time and highlighting your
[y central Time | geographic time zone.
[y Meuntain Time
™ Mountain Standard Time

GUIDED INSTALL - SET TIME/DATE SCREEN
ILLUSTRATION 3-4

7. Proceed to the Verification tab. Once in the Verification tab, look at the pass or fail status
of the entries. If any entry has a failed status, the <Install Software> button will not be
active. Failed entries will be due to missing entries, or entries not in the correct format. Go
to the tab with the error and correct it, then push the <Install> button to open the
Verification tab again. If all entries pass verification at this point, push the <Install
Software> button again to begin the MR Apps load. The MR Apps load will take 20-30
minutes, depending on the machine being loaded.

12
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Note
It is not necessary that any one tab be filled out in any particular order. Just all
required configuration tabs must be filled in or the install will not continue. The
Verification Tab will list any formatting errors as well as current settings. See
lllustration 3-5 for an example of a failure in the Verification Tab in networking (in
the example, the Host IP Address is an incorrect format).

Mount/Confi | Patches | Reset Image DE ' SprSnap Log file |

SaveiRestore  Option Keys I's :! P | Load ServiceiPictureThisilIP
~ SetExam Number | SetDisk Limit | DASM  VCR Setup | HIS/RIS | Set Time/Date
Home TFE Network info f_ﬂ System Configure = Hd4 Errors are shown in red on color monitors,
#{ or light gray in Monochrome monitors.

Verification
Verification Failed! A

Error details are shown in the message
area at the bottom of the Install GUI. This
failure is due to an incorrect IP address
format. The correct format is:

XXX XXX XXX XXX
The <Help> button on the Network Tab
gives the correct format.

GUIDED INSTALL - VERIFICATION SCREEN
ILLUSTRATION 3-5

13
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8. Once the MR Apps load is done, the popup in lllustration 3-6 is displayed. Push the <OK>
button to close the popup.

= Aesage ]
Software Installation Done

At thas Point you can:
* Restore Info
* Load OptionKey
* Load Bestneted Senvace

Note: System Will Reboot When You Exit Guided Install

5

GUIDED INSTALL — SW DONE SCREEN
ILLUSTRATION 3-6

9. At this point the GUI will change from the Install phase to the Configure phase. If a
Savelnfo info MOD is available for this site, proceed to the Save/Restore tab and Restore
the system info. If no Savelnfo MOD is available, go to each tab in the Install GUI and fill
in or update all system information manually. A help button is available on each tab, which
will open a popup box with information on the required data and its format for that page.

10. When the Restorelnfo is finished a popup will open telling the installer that upgrade scripts
must be run. See lllustration 3-7.

After upgrading to new software you
MUST run all upgrade scripts.

To do so click on OK and then choose
option to run all scripts from the menu

that comes up.
This will update config files and protocols
to work with the software.

0K Cancel

GUIDED INSTALL — UPGRADE SCRIPTS MESSAGE
ILLUSTRATION 3-7

14
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11.

12.

13.

14.

15.

Push the <OK> to continue. The upgrade script menu will open (see lllustration 3-8).

This script upgrades the system config files
for LFC software. After Restore Info is completed,
the following UP scripts must be run before scanning.

1. ConfiguP Update MRconfig.cfg/GradientConfig.cfg files
2. Coilup Update CoilConfig.cfg file

3. Protocol1lUp Upgrades 8.2.5/83 Protocols

4. ProtFormat Reformats site protocols names

5. Restore_License Must be run individually

6. Run all scripts Except Restore_License

7. Exit Return to Guided Install.

GUIDED INSTALL — UPGRADE SCRIPTS MENU
ILLUSTRATION 3-8

You must always run these updates in the following order:

a. Type: 6 <Enter> This will take about 1 minute to run.

b. Type: 5 <Enter> This will take < 1 minute to run.

c. Type: 7 <Enter> This will close the menu and return to the GUI.

Note
Refer to Appendix A for parameters updated by the Configup scripts

Once back on the Guided Install screen, use the cursor to select <File> and then <Quit>
at the top left of the GUI. When the GUI shuts down, the system will reboot and all
changes restored or made will be set.

After the system has finished rebooting, once again log in as root. Password is operator.

You will be asked, once entering the root desktop, if you want to start the Install GUI. Push
the <Yes> button.

When the install GUI opens, go to the Load ServiceSW/Picture this/InSite tab and install
service software. (Restricted Service Software is only available for GE use; Advanced
Service Software is only available to sites with a valid Advanced Service Package Limited
License.) GEMS Field Engineers loading GEMS Restricted Service Software should also
configure InSite Interactive at this time (see lllustration 3-9). Follow the instructions given
in popup windows as presented.

15
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X 1IPConfig K
InSite Interactive Platform Configuration
flnfurmatinn rPruDiags rHeaIth Page rDeuice Connection rInSite Checknut|

Connection Device Configuration
Last Update: Fri Aug 13 15:50:42 CDT 1999

Device Connection Type |Modem

Select the InSite Connection Type above, or select the Modem settings given below and Press

APPLY - Toupdate the modem and modem configuration files with
model and eountry defanlts.

CUSTOM - For other modem settings.

Dial -out Prefix Dialing mode

8, |v| Tone

Modem Type Country

| USRobotics Courier ¥.34 or Y.Everything - | | Default — A1l Others «

CPU Serial Port Name CPILI Serial Port Speed

Ffdev/ttvfl « 115200 -

| APPLY | cusTom>> |

Status: [IP Configuration Tool Ready for Input... | EXIT |

CONFIGURE INSITE MENU
ILLUSTRATION 3-9

16. After service software installation, move through and check the accuracy of each tab.
Insure all system options for the site are active. If needed, load software option keys at
this time. If the site has any of the following option keys, they must always be reloaded, as
they are not saved with Savelnfo: VI, Voxtool, FuncTool, and Clairview.

Note
Release 8.3 version M4 and later software come with two software MOD keys
that must always be reloaded. These two MOD’s (two sides on one MOD and
one side on the other MOD to load) contain the LX Tools software that is shipped
with every system.

17. Turn YP on only if the site’s external network requires it. If YP is turned on, the system will
take longer to boot (2 to 4 minutes). Be aware there is a small delay that may not be seen
on other sites.

18. After information as been restored from MOD or changed in a tab, and configuration
updates have been run, push the <Configure> button on the bottom of the tab to apply
the configuration.

16
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If the <Configure> button is not pushed to commit changes to a tab, or an error is present
in a tab, a question mark will be seen on the tab, as shown in Illustration 3-10.

The “?” indicates these tabs had data
added or changed and the

vc| <Configure> button was not pushed
Hardw Defore leaving the tab, or there is
some other error condition in the tab.

Mount/Configure | Patches | Reset Image DB | SprSnap

_ Verification | Save/Restore | Opti

Set Exam Number |
Home | §d Metwork Info

ystem Configure

CONFIGURATION PROBLEM EXAMPLE
ILLUSTRATION 3-10

19. Perform a Savelnfo to save the latest changes.
20. Exit the install GUI by selecting <File> then <Quit> from the top of the interface. If any
error conditions still exist, you will be warned that no changes will be made. If no error

conditions are found, the GUI will save user parameters.

21. Reconnect the following hardware at this time if it was disconnected at the beginning of
the install:
* Network Interface

22. Log out of root and reboot the system.

23. This concludes the software load. Continue with Section 5 to update the Monitor gamma
settings.

17
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4- RECONFIGURING THE SYSTEM USING THE INSTALL GUI

If this is a new/upgraded Signa installation or if the system just needs to be re-configured
between software loads, do the following to start the Configuration GUI:

1. With Signa up and running, go to the service desktop and push the <Install> button on the
toolbar. A C-Shell will open and ask for root password (“operator” <Enter> is the default).
The Install GUI will load and start.

2. Help documentation is built into the GUI. Push the <Help> button on the tab you need
information for in the GUI. Push the <Next> button to move through tabs in order. Modify
entries to match your system as required. When satisfied, push the <Configure> button at
the bottom of the tab page or wait until all tabs have been modified and go to the
“Verification” tab. Review changes made are correct, then push the <Configure Tab(s)>
button to update the system (see lllustration 4-1).

Mount/Configure | Patches Reset Image/Error DB ' SprSnap | Log file |
Save/Restore = Option Keys | SCP |
Set Exam Number | SetDisk Limit | DASM | VCR Setup | HISIRIS
Home = [ MetworkInfo |  System Configure |  Hardware Configure |  EdjfPatient Data

Verification

Verification FPassed!

EEAED1 EEEE-

VERIFICATION MENU — CONFIGURE TABS
ILLUSTRATION 4-1
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3. Before exiting the GUI, insert the Savelnfo MOD or new MOD into the drive. Go to the top
left corner of the Install GUI and select <File> and then <Save GI Configuration to
MOD>. This process does not create a Savelnfo disk. It just creates a copy of the
information already entered in the GUI tabs for use in the next software install.

4. Exit the install GUI by selecting <File> then <Quit>. If any error conditions still exist, you
will be warned that no changes will be made before exiting.

Note
The GUI will not automatically reboot the system in configure mode. It will be up
to the user to reboot after making configurations.

5. If changes were made to the system configuration, select [System Shutdown] and reboot
the systems for changes to take effect.

6. For new system installations or upgrades with preloaded software, continue with Section 5,
Monitor Gamma Value Reset.
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5- MONITOR GAMMA VALUE RESET

After a complete software load has finished, do the following steps to update the monitor
configurations. This insures compatibility between monitor and camera.

1.

In the C-Shell, type su <Enter> to log in as root; enter the root password (default is
operator).

a. Type jot /usr/g/colorPix/colorPix.cfg <Enter> to edit the colorPix.cfg file.
b. Modify the numerical value for “‘gamma” to 1.05

In the jot window, select File -> Save, then File -> Exit to save the changes. This
modifies the gamma value so whenever the system reboots, the new value is not lost.

In the C-Shell, enter the following:
Color LCD Monitor: gamma 1.05 <Enter>

This is in addition to steps 2 and 3. This step immediately changes the gamma value
without the need to reboot the system.

If you performed a complete software load, you are now done. For new system
installations or upgrades with preloaded software, continue with Section 6, Set Time/Date
Tab to complete the software reconfigurations.

20



GE MEDICAL SYSTEMS HOST SOFTWARE INSTALL OPENSPEED
REV 1 OW2SCA9A.DOC

6- SET TIME/DATE TAB

The Time/Date tab is the only tab that the Configure button will never be highlighted to set
options. There are separate buttons for configuring this tab (see Illustration 6-1). If you need to
re-configure the Host time and/or date at any time, do the following:

1. Select the Time Zone your system is located in, then push the <Set Time Zone> button.

2. Select the date and local time, then push the <Set Time/Date> button.

Display MODYCDROM Patches Reset linage/Error DB SprSnap | Log file

Verification ~ ©oociesione Option Keys SCP Service SWiPicture This/Insite
Set Exam Number | Set Disk Limit = DASM |  VCR Setup | HISIRIS

Home |  MetworkInfo = System Configure = Hardware Configure | Edit Patient Data |

- Bt Thine 2ok

I_I Tl RS O Ldl s 1S
@ [ United States
[y Eastern Time
[y Eastern Standard Time
[ central Time B
[y mountain Time
™ Meuntain Standard Time

I*]

After selecting the
time zone the system
IS in, push the <Set
Time Zone> button.

After selecting the
date and time, push
the <Set Time/Date>
button.

3 I

|| o

Set TimefDate

SET TIME/DATE MENU
ILLUSTRATION 6-1
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APPENDIX A - HOST SOFTWARE INSTALL WORKSHEETS

Host IP Address: The Host IP should be obtained from the site network administrator if the scanner
will be connected to the sites internal network. Or obtain and address by calling the OnLine Center
(OLC) MR Support.

IWS PC IP Address: The IWS PC IP should be obtained from the site network administrator if the
scanner will be connected to the sites internal network. Or obtain an address by calling the OnLine
Center (OLC) MR Support.
FE Laptop IP Address: The Laptop IP should be obtained from the site network administrator if the
scanner will be connected to the sites internal network. Or obtain an address by calling the OnLine
Center (OLC) MR Support.

TPS Subnet Address: The TPS is on a subnet of the Signa LX scanner. A default address is loaded
during the load from cold process and it should not be changed.

Hostname: This is the network name given to the scanner host computer.

Hospital Name: The Name of the hospital or other facility where the Horizon LX is installed. Name
can include characters and/or integers up to 32 characters.

Doctors Title: The title to be used at the scanning site by the reading physician (Radiologist or
Diagnostician).

Suite ID: Name of the Suite (if any) the scanner will be connected to. Leave blank otherwise.

Unique ID: The Unique System ID is a 16 alphanumeric character string assigned at the time the
system is first installed. The Unique system ID is assigned by GE CARES when the first dispatch is
opened to document the start of installation.

Service ID: The Service ID is a 16 alphanumeric character string assigned at the time the system is
first installed. This is the same number that GE CARES uses to track financial and administrative data
for the system.

Weight Unit: The weight system to be used by the scanner. Kilo Grams or US pounds.

Monitor type: The type of monitor the scanner will be using.

Windows 95 OEM Number: The Microsoft OEM Number found on the “Proof of Authenticity” for
Windows 95.

NetMask: For new installs, the Netmask should be obtained from the site network administrator if the
scanner will be connected to the site’s internal network. If this is a stand-alone system, use the default
netmask. For Release 8.3 and later, the netmask value is available from the Install GUI. For Release
8.2.5 systems, do the following to obtain the netmask value: [System Shutdown], Log in as Root, type
operator <Enter>, select [Reconfig] then [Basic Network Setup] to view the netmask.
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A-1 OpenSpeed Hardware Configuration
Illustration A-1 shows the OpenSpeed Hardware Configuration setup.

0.7T
Base{HORIZOH) SR25
G280

0.7T Analogic Solid State RF GRFD -

689 nMR Magnet

CERD 1/4 Ch 125 125 125 125

OPENSPEED HARDWARE CONFIGURATION
ILLUSTRATION A-1
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APPENDIX B - CONFIGURING MOUSE FOR LEFT HANDED USE

The system Host mouse is default configured for right handed use. It can be configured for
permanent or temporary left handed use.

B-1 Configuring Mouse For Permanent Left Handed Use

1. If Signa is up and running, you must first log out and bring the system up to the Login
screen. Otherwise, turn the system on and proceed to the Login screen.

2. Log in as root. The system default password is “operator”. On the root desktop, use the
mouse cursor on the ToolChest and click and slide through [Desk Top] then [Customize]
then [Mouse].

3. Push the [Left Handed] button under Mouse Mapping, then push the [Close] Button to
accept the changes. See lllustration B-1.

Mouse Acceleration:
1 Slow Fast  Finer Control
<> <& <> @ @ [¥]

| Acceleration
_l Threshold

Mouse Mapping:
| & Righthanded  Test:||
" Left handed

Click Speed:

| stow Fast Finer Control
13 ¢ T

[Left handed]
button.

[Close]
button.

SET TIME/DATE MENU
ILLUSTRATION B-1

4. Log out of the root desktop and reboot the system. To change the mouse mapping back to
Right handed. Repeat this section but push the [Right Handed] button, then reboot the
system.
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B-2 Configuring Mouse For Temporary Left Handed Use

Using this method will change the mouse mapping from right handed to left handed, but only
until Signa is rebooted, when it will revert back to right handed mapping.

1. If not already at the Signa scanning level, go there. Open a command window and on the
command line type: mouse <Enter>.

2. Push the [Left Handed] button under Mouse Mapping, then push the [Close] Button to
accept the changes. (See lllustration B-1.)

3. To reconfigure the mouse back to right handed operation, repeat this section but push the
[Right Handed] button, or reboot Signa.
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APPENDIX C - DISK DRIVE LOW LEVEL FORMAT

This section describes how to do a low-level format of the disk drives. A low-level format
should only be done if loading a different Operating System (OS) or if suspected bad blocks
on a disk drive are causing system problems. Depending on the system and disk drives, this
procedure can last up to 1 hour per drive or as little as 20 minutes per drive.

1. Insert the IRIX 6.5 CD labeled “Boot/Update” into the CDROM Drive on the workstation
(right side).
Note
User responses are bolded text

2. With the system up and running, go to the service desktop and select [Shutdown]. If the
system is not up and running, switch on power at this time.

3. When prompted, click on the [Restart Button]. Stop the reboot process by clicking on the
[Stop For Maintenance] button when it appears.

Select [Stop For
Maintenance] button.

Stop For Mairtenance

4. Next, click on the [Enter Command Monitor] button when it becomes available. Type the
following:

>>boot -f dksc(1,3,8)sash64 dksc(1,3,7)stand/fx.64 --x <Enter>

5. Continue typing as follows:
fx: "device-name" = (dksc) <Enter>
%x: ctlr# = (0) <Enter>
1"x: drive# = (1) <Enter> or 2 <Enter> if doing the second drive.
%x:dﬁo<EMeﬁ>
'Press <Enter> to accept current parameters.
:pre: Yes <Enter> to start the format.

6. The format can take up to 1 hour, depending on the system and disk drives that are being
formated. There will be no prompts to the user while the format is running. Be patient and
do not interfere with the system. When the format is finished the system will prompt with:

Format conpl et ed successfully

26



GE MEDICAL SYSTEMS HOST SOFTWARE INSTALL OPENSPEED
REV 1 OW2SCA9A.DOC

f x/ debug>

7. Reset or power cycle the computer to exit debug and proceed to Section 2 of this
document to proceed with the OS (Operating System) load for the system.
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APPENDIX D - GENERAL INFORMATION AND NICE TO KNOWS

D-1 Bore Temperature Sensor - Must Be Working!

If the bore temperature sensor is disabled, sites with iDrive software will have problems. Sites
running the iDrive software must have a functional bore temperature sense circuit. The
symptom for a non-functional Bore sensor will be evident when an iDrive scan is attempted,;
the prescan will complete OK, but the scan will stop immediately after the first pulse is heard in
the body coil. No images will be produced and no errors will appear in the log.

If the system has iDrive software (as listed in Option Key tab of Guided Install), to verify
functional bore temperature circuit, set up the scan in Table D-1 (or any other Real Time scan).
Download the scan and select [Scan]. If prescan completes and the scan continues to run,
you have a functional bore temperature circuit. If prescan completes OK, but the scan stops
immediately after the first pulse, check the bore temperature circuit.

TABLE D-1
IDRIVE SAMPLE PROTOCOL

PATIENT REGISTER

PATIENT INFORMATION

Patient Id
Patient Name
Weight (Lb)
Landmark

PATIENT PROTOCOLS

PATIENT POSITION

[New Pt]

geservice

test

111
[Landmark]
[Sternal Notch]

[Patient Position]

SCANNING RANGE
FOV.

Slice Thickness.
Spacing

Start

End..

# Slices

L/R Center

P/A Center

Table Delta

ACQUISITION TIMING

[32]

[7

[1.5]

0

0

1 (default)

0 (default)

0 (default)
0.00 (default)

Patient Position [>] [Supine] Freq [128]
Patient Entry. [>] [Head First] Phase [128]
Coil [...] [Body] [Accept] | NEX [1]
Phase FOV 1.00 (default)
IMAGING PARAMETERS Freq Dir [>] [R/L]
Plane [>] [Axial] Auto Center Freq [>] [water]
Mode [>] [2D] Autoshim [on]
Pulse Seq [...] [FGRE] [Accept] | (lowest window) [Save Series]
Imaging Options [Real-time]
Psd Name no entry
Protocol no entry
SCAN TIMING
# of Echoes 1 (default)
TE [Mn Full]
TR. [Mn]
Flip Angle [20]
Bandwidth [62.50]
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D-2 Signa Power up Delay

When Signa is first powered on there is a considerable period of time that nothing is seen on
the monitor; up to 4 minutes depending on the computer type. The system is checking
configurations and starting software processes at this time. If you are concerned that the
system is hung, push the <Esc> button on the top left side of the keyboard. The system will
then post to the monitor its entire boot up activities.
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